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Freeway Exercise 

Solutions for OEMs, FreeStudio 

Thermostat exercise 
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Chapter 1 

Function Description 

 

Goal: 

Describe thermostat flow chart  
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Thermostat cycle 

∆ Set point  Temperature 

Actuator 

ON 
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Thermostat states (function description) 

Actuator 

 

OFF 

Actuator 

 

ON 

Temp ≥ Setpoint+∆ 

Temp < Setpoint 
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Chapter 2 

Programming 

 

Goal: 

- Familiarizing with programming environment 

- Creating Thermostat Function Block 
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Creating New project 

2*click 

2*click 

1 

2 
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Creating New project 
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Creating New project 
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Programming environment 

1 
2 

3 

4 

5 

5 

6 

7 5 
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Programming Languages 

The FREE STUDIO platform is compatible with all 5 standard programming 

languages (IEC 61131-3). 

 

 

 

 

 

 

 

 

5 programming languages, 2 text-based and 3 graphics-based: 

• ST, Structured Text,language text 

• FBD, Functional Block Diagram language graphical 

• LD, Ladder language graphical 

• IL, Instruction List language text 

• SFC, Sequential Function Chart language graphical 
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Thermostat program 1. Right click on the programs 

2. New program 

3. Select language 

4. Name it 

5. Assign it to the background or timer task 

Note: The main (default) program can be 

deleted if not used (Rename is possible, 

Editting language is not possible). 

 
  
 

See the next slide for Task detail  

1 2 

3 

4 

5 

* 
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Associating a program to a task 

For a program to run, it must be associated to a task. 

There are various types of tasks: 

• BOOT Task runs once only at system start-up. 

• Init. Task runs each time the application is downloaded and after BOOT. 

• Timed. Task runs at regular intervals which can be set by the developer.  

The default setting is 100ms. 

 

 

 

•Background. Task runs with low priority after the Timed tasks (between the end 

of one Timed task and the start of the next), it can be interrupted in case of long 

execution or executed more than 1time in case short execution. 

Note Each new project has the main program associated to the background task 

(the main program can still be eliminated and/or associated to other tasks). 

To activate a task, go to the task you want, right-click and select Add program 
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Tasks 
 

 

 

• BOOT Task runs once only at system start-up. 

• Init. Task runs each time the application is downloaded and after BOOT. 

• Timed. Task runs at regular intervals which can be set by the developer. The default setting is 

100ms. 

•Background. Task runs with low priority after the Timed tasks  

(between the end of one Timed task and the start of the next). 

Period of  

task timed 

Execution 

time of 

task timed 

Period 

task timed 

Execution 

task timed 

Period of 

task background 

Execution time of 

task Background 

Actual execution time, background task 
Start Execution 

Background Task 

Read  

Input 

Update 

Output 

Execution 

task Boot 
Execution 

task Init 

Update  

Display 

Read  

Input 

Update 

Output 

Read  

Input 

Update 

Output 
Read  

Input 

Update 

Output 

Update 

Output 

Update  

Display 

Executed only after a 

download 
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Assigning program to the task 

 

Tasks►Background ►right click ►add program 
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View FBD toolbar 

1. View 

2. Toolbars►FBD bar 
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New function block creation 

1. Right Click 

2. New function block 

3. Select the language 

4. Assign a name  

5. Double click on the Hysteresis to open the editor 

related to the selected language. 

 

Note: Try to create function if the block does not require 

static RAM, it will optimize the RAM usage 

 

 

5 
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Insert record 

1 

2 

5 

4 3 

6 

4 

5 & 6. Optional 
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Inside Hystersis FBD 

Compile result is valid as soon 

as FBD used in the program 

Set point 

∆ 

Probe Alarm 

Actuator 
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FBD in Background 

1. Double click on the Thermostat programt to 

open the editor that is related to the program 

2. drag & drop 

3. Name it 

4. Add new network 

 

 

Drag & Drop 

1 
2 

3 

2 
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Set password for written FB 

You can prevent access 

to your written codes 

inside of FBD by cript. 
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FBD toolbar… 

1 2 5 4 3 6 7 8 9 

1. Connection 

2. Watch 

3. New block 

4. Variable 

5. Constant 

6. Return 

7. Jump 

8. Comment 

9. Increase number of pins 

10. Decrease number of pins 

11. Display enable I/O pins 

12. FBD properties 

13. View source 

 

10 11 12 13 

11 

11. The output will not 

update if En=False 

9 
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Cross Reference 

1. Find in project (cross reference) 
1 

1 
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Compile/Build 

Compile 

 

 

 

Double click on the error to 

refer to the error source 
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Chapter 3 

Resources 

 

Goal: 

Defining the resources: 

-   Assigning physical Input/output 

-   EEPROM parameters 

-   Status variables 

-   Menu definition and navigation 
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Physical I/O Mapping (Base Unit)... 

1 

2 
3 

1. Resources 

2. I/O mapping 

3. Local 

4. Name variables 

 

 

 

 

2. I/O Mapping definition: 

 

Local: Base I/O 

Extend: Expansion 

Remote: Keyboard 

 

 

 

 

 

4 
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...Physical I/O Mapping (Base Unit)... 

After saving the project, all 

the defined resources will 

be available under Global 

shared folder;  

Mappings in case of I/O 

 

1 

2 

2 
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...Physical I/O Mapping (Expansion) 

Note. 

In case of loosing 

communiucation between Base & 

expansion: 

All DO‘s = 0 

All DI‘s = False 

All Probes = -32768 

 

3. It can use as communication 

alarm variable 

4. They can only use in watch 

 

 

1 
2 

3 

4 
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How to configure I/O types, range? 

1. Menu Developer ► Open with free studio device 

 

Note: BIOS parameters are also available on the installation manual 

 

 

 

 

 

 

1 
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Check FS Device parameters description... 

1 
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...and define the Application BIOS Default 

1. BIOS parameters 

2. Add 

3. Select the name 

4. Select the type 

3 1 

2 

4 
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EEPROM parameters 

3 

1. Resources 

2. EEPROM parameters 

3. Add 

4. Define required „retain“ data 

5. 1% resolution 

      Format XXX.Y 

Note:Default values are written to the 

target  only by Free Studio Device 

 

1 

4 5 

App. Type : IEC variable type 

Device Type : FS Device / Display type 

App. Type = Scale x Device Type + Offset 

 

2 
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EEPROM Properties 

1 

1 

EEPROM Parameters: 

 

App. Type : IEC variable type 

Device Type : FS Device / Display type 

App. Type = Scale x Device Type + Offset 

 

Note. 

Dynamic setpoint by the other parameters 

Min/Maxis possible. 

 

4 

2 

3 

4 2 3 
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Status Variables 

1 

2 
3 

1. Resources ►Status variable 

2. Add new record 

3. Define required RAM data 

4. Valid range 

 

Note: Same properties as 

EEPROM + read only 

App. Type : IEC variable type 

Device Type : FS Device / Display type 

App. Type = Scale x Device Type + Offset 

 

4 

3 
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Alarms 

1 

2 

3 

4 

1. Resources 

2. I/O mapping 

3. Alarm 

4. Add 

   4.1   Name 

   4.2   without short name 

   4.3   7 segments preview 

   4.4   with short name 

   4.5   7 segments preview 

- It is automatic folder which display 

the Alarms, if value is 0, no display  

In AL folder if alarm value is 1,  

displays  the short name. 

 blinks if value> than 1. 

- In case of any alarms, the red  

triangle icon in the display is on. 
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Fundamental state display configuration 

- Display 

- Fundamental state display 

- Desired variable in the display 
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Menu Program – Add Folder 

1. Menu Prg. 

2. Add Menu 

3. New Menu, name it (Cfg) 

4. 7 segment preview 

  

 

 

 

 

1 2 3 4 
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Menu Set – Add Folder 

1. Menu Set, Right Click Add Menu 

2. New Menu, name it (Setting Menu) 

3. 7 segments preview 

  

 

 

 

 

1 2 3 
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Add/Remove elements to folder 

1 3 

2 

1. Add 

      Open the list sorted by names 

2. Select the parameter 

3. Add again 

4. Select the other parameter 

  

 

 

 

 

4 
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Add/Remove elements by drag & drop  

Drag & Drop 



41 Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh 

Menu Program – How to Access 

To form & define the program button function: 

1. Menu Prg, access by pressing Prg button in simulation 

2. Menu Prg, access by pressing esc.& set buttons 

simultaniously on the product 

3. Scroll up or down into the defined variables ▲▼ 

  

 

 

 

 

1 

2 

3 
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Menu Set – How to Access 

To form & define the set button function: 

1. Access to the set menu by pressing set in simulation 

2. Access to the set menu by pressing set on the product 

3. Scroll up or down into the defined variables ▼▲ 

  

 

 

 

 

1 

2 

3 
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Menu architecture 

MSet 

Main Menu 

Al Pass Par 

I/O M 

Set Prg 

↑ ↓  ↑ ↓  

Main Menu 

↑ ↓  ↑ ↓  

Cfg 

Diff SetP 

Temp 

Main Menu 

Set 

F5 

Value Value 

Value 

0 Err1 

Free 

Prg 

Cf 

Pass Par 

↑ ↓  ↑ ↓  

Set 

Cf** 

Set 

F5 

Set 

Set 

↑ ↓  ↑ ↓  

Set Set 

Set 

Set Set 
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Project / Global Shared 

Drag & Drop 

All the resources are available in the 

project tab under Global Shared folder 

(after saving or compiling the project) 
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Using physical I/O  

Drag & Drop 
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System LED setting 

1 

2 

4 

3 
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System local LED assigning 

1. 2*click 

2. Variable property 

3. Dedicate required LED 

4. Type [6] ► Output ► OK 

5. Type [9] ► Output ► OK 

6. Type[10] ► Output ► OK 

7. Dedicated LED‘s 

 

 

 

 

 

1 
2 

3 

4 5 6 

7 
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Connecting dedicated LED‘s to the FBD 

1 

3 

2 

4 

5 

Digital Input map 

 

 

 

Digital output map 

 

 

 

4 
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Valorize Fundamental State Display 

1 

3 

2
v 

4 7 

* Move command is mandetory to connect two variables. 

5 
6 

1. Insert bottom (new network) 

2. Adding new network 

3. Select Move block 

4. Drag & drop to new network 

5 & 6. Mapping ◄► Variables 

7. Connect to Move block 
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Compile/Build 

Compile 

 

 

 

Double click on 

the error to refer to 

the error source 
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Chapter 4  

Simulation/Debugging – Part 1 

 

Goal: 

Debugging created FB by different off-line 

simulation tools such as Watch or Oscilloscope 
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Off line simulation mode 

Debug►Simulation mode ► 

1. Debug 

2. Simulation mode 

3. Name it ► OK 

4. If differs or no code 

5. Download  the code, OK 

6. Reset Variables 

 

 

 

 

1 2 

5 
4 

3 6 

5 

2 
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On-Line Status / Application Status  

 

The state of communication is shown in a small box next to the right border of the 

Status bar.  

If you have not yet attempted to connect to the target, the state of communication is set 

to Not connected.  

 

 

When you try to connect to the target device, the state of communication becomes one 

of the following:  

-Error: the communication cannot be established. You should check both the physical 

link and the communication settings.  

 

 

-Connected: the communication has been established  
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On-Line Status / Application Status 

Next to the communication status there is another small box which gives 

information about the status of the application currently executing on the 

target device.  

When the connection status is Connected, the application status takes on one 

of the following values.  

-No code: no application is executing on the target device. 

 

 

--Diff. code: the application currently executing on the target device is not the 

same as the one currently open in the IDE; moreover, no debug information 

consistent with the running application is available: thus, the values shown in 

the watch window or in the oscilloscope are not reliable and the debug mode 

cannot be activated.  
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On-Line Status / Application Status 

--Diff. code, Symbols OK: the application currently executing on the target 

device is not the same as the one currently open in the IDE; however, some 

debug information consistent with the running application is available (for 

example, because that application has been previously downloaded to the 

target device from the same PC): the values shown in the watch window or in 

the oscilloscope are reliable, but the debug mode still cannot be activated.  

 

 

-Source OK: the application currently executing on the target device is the 

same as the one currently open in the IDE: the debug mode can be activated. 
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Assigning local variable to the FBD 

2 

1 

3 

3 

1. Add new record 

2. Name it 

3. Define the type from object browser 
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Debug mode/Changing values 

 

1. Use the local variable for debug 

purpose instead of the phisical variable 

2. Delete the phisical input 

Ambient_Temp. 

3. Drag and connect the new variable 

4. 2*click on required variable 

5. Edit and Set the value. In probe 

disconnection, short circuited or 

broken the value= - 32768 

6. Check the Output status amd the 

Alarm status;  

7. Debug mode (optional) 

8. Live (continuous) debug mode 

(optional) 

 

 

7 

4 

1 

2 

3 

8 

Edit value 6 

2* Click 
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Watch configuration 

Save watch list 

Drag & Drop 

Watch list formats 

Watch list is 

independant from 

live debug mode 
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Watch/ drag & drop 

1. Select watch icon 

2. Select the variable 

3. Select the watch 

4. ► OK 

5. It adds to watch list 

 

 

 

 

1 

2 

4 3 
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Watch Configuration/ST language 

1. Select the variale 

2. Double click 

3. Drag & drop it directly to 

the watch properties 

 

 

 

1 2 

3 

* 
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Oscilloscope 

View ►Tool windows ► Async graphic windows ► 
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Assigning variable to the oscilloscope 

Drag & Drop 

Up to 8 channels could be 

traced simultaneously 
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Assigning variable to the oscilloscope 

1. Select watch icon 

2. Select the variable 

3. Select the Oscilloscope 

4. It adds to oscilloscope list 

 

 

 

 

2 

4 

3 

1 
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Oscilloscope tools/starting & stopping data acquisition  

 

 

When you add a variable to the Oscilloscope, data acquisition begins 

immediately.  

However, you can suspend the acquisition by clicking on Pause acquisition. 

The curve freezes (while the process of data acquisition is still running in 

background), until you click on Restart acquisition.  

 

In order to stop the acquisition you may click on Stop acquisition. 

  

In this case, when you click on Restart acquisition, the evolution of the 

value of the variable is plotted from scratch. 
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Oscilloscope tools/ Vertical split 

 

 

 

1.Selected track‘s vertical show all 

2. Horizental show all 

3. Show all values 

4. When you are watching the evolution of two or more variables, you may want 

to split the respective tracks. 

5. The tool highlights the single values detected during data acquisition.  

You can click on the same item again, in order to go back to the default view 

mode. 

6. The Oscilloscope includes two measure bars, which can be exploited to take 

some measures on the chart. 

1 4 3 2 5 6 
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Oscilloscope tools/ Setting the scale of the axes 

When you open the Oscilloscope, Application applies a default scale to the axes. 

However, if you want to set a different scale, you may follow this procedure:  

 

1) Open the graph properties 

2) Set the scale of the horizontal 

 axis & sampling polling rate  

3) Specify a distinct scale for the 

 vertical axis.  

4) Confirm your settings.  

2 

4 

3 

1 
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Oscilloscope/export 

1. Save icon 

2. Name & format defining 
    -OSC: simple plain-text file, containing 

time and value of each sample 

    -OSCX: XML file, that includes more 

complete information 

3. Open it via Excel (OSCX ) 

 

 

 

1 

2 Available formats 

 

 

 

2 

3 
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Chapter 5 

Simulation and Debugging – Part 2 

 

Goal: 

On-Line simulation mode, testing of: 

-   Physical I/O  

-   7 segment display  
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Off line simulation mode 

Debug►Simulation mode ► 

1. Debug 

2. Simulation mode 

3. Name it ► OK 

4. If differs or no code 

5. Download code, OK 

6. Reset Variables 

7. Debug mode (optional) 

8. Live debug (Continuous) mode (optional) 

 

 

 

1 2 

5 
4 

3 6 

8 7 

5 

Smart 
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Simulation tools 

1. Active code execution 

2. Show I/O panels 

3. Show HMI window 

 

 

 

 

1 2 3 
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Open Free Studio Device from Application 

1. Developer ► Open with Free Studio Device 

 

 

 

 

1 
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Free Studio Device (Simulation Target) 

Connect to the target►Connected feedback 

 

 

 

Note: Free Studio Device does not download the code in Simulation, it 

is used only for setting EEPROM parameters and check Status 
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2 

Read / Write Values 

1. Connect to the target►Connected feedback 

2. Application►Project►Cfg 

3. Cfg menu►non aligned value with target (Red) 

4. Auto refresh mode (optional) 

5. Select all parameters (or selective) 

6. Write parameter (all or selective)+ download all 

7. Aligned values  with the target (black) 

 

 

 

1 

3 

4 

5 

6 

7 

6 
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Menu Navigation 

Start 

 

 

 

- Prg - 

 

 

 

Set 

 

 

 

Set 

 

 

 

▲,▼ 
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Menu Navigation 

Start 

 

 

 

Set 

 

 

 

Set 

 

 

 

Set 

 

 

 

▲,▼ 
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Setting the setpoint 

Start 

 

 

 

Press Set to validate 

Press esc  to cancel 

 

 

 

Set 

 

 

 

▲,▼ 

 

 

 

Defaul value aligned with 

 the Free Studio Device 
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Setting the differentiation 

Start 

 

 

 

Press Set to validate 

Press esc  to cancel 

 

 

 

Set 

 

 

 

▲,▼ 

 

 

 

Defaul value aligned with 

 the Free Studio Device 
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Message 

Out of range message 

Only can disply: 

- 99.9.....999.9  

 

 

 

 

Free Studio Device does 

 not write default values 
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Testing program/applying values 

 Setpoint=26.0, Differentiation=10.0 & Ambient_Tempereature =37.0  

 DOL1= ON & ☼ = ON   

 

 Setpoint=26.0, Differentiation=10.0 & Ambient_Tempereature =25.0 

 DOL1= OFF & ☼ = OFF  

 

 Setpoint=26.0, Differentiation=10.0 & 26.0<Ambient_Tempereature<36.0  

 DOL1= ON & ☼ = ON 

 

 Ambient_Tempereature =-32768  

=> DOL1= OFF , ☼ = OFF & DOL2= ON (probe disconnection alarm= ON)  
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Smart Project Architecture 

●Application is the programming starting point. 

  

●Device is used to download the overall compiled project and it is the only tool able 

to write EEPROM parameters. 

 

●From Application it will always be possible to open Device directly without having 

to launch the program using the FREE Studio icon. 

 

Download 

Code & 

EEPROM 
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Chapter 6 

Connection to Smart 

 

Goal: 

DMI interface driver installation and connect to the target  
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DMI interface setup WIN 7 

●As soon as the DM interface is connected, the Windows 7 operating system 

recognizes the newly connected hardware. The steps to be followed are 

described below. 

1.Once the hardware is connected, the message shown in the figure will 

appear: 

 

 

 

Click on the message to start the  

Guided installation procedure  

Or you can manualy find it at: 

 

 

Device manager ► other devices ►   

 

 

 

Note: Connection procedure: 

Connection: first USB then TTL 

Disconnection:  first TTL then USB 
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Update driver software 

2. The screen shown below will appear: select the second option to identify the 

driver 

 

 

 

 

 

 

 

 

 

3. In the next screen, select the installation path for the FREE Studio program. 

Unless changed during installation, the path will be as shown in the next  

figure. 
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Update driver software 

4. Once you have selected the correct path, the screen shown below will 

appear: select Install this driver software anyway 
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Update driver software 

5. The screen shown below will appear, indicating that the action has been 

performed. 

 

 

 

 

6. On completion of the process, the screen shown below will appear, then close. 
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DMI Test via FS Device 

To check correct installation of the driver and the port to which the hardware 

has been allocated, check the Windows screens shown below: 

Default Address 

range is between 

1 to 5 
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Connection to Smart 

To download the IEC applications of Studio from the personal computer to the 

Smart target device, 

 

 

 

                                                    Note: in “Direct”, Smart must not be                     

                                                              connected to earth 

                                                              - it can switch on Smart without external  

                                                              power supply 
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Smart 

Preliminary operations 

In order to download the application correctly: 

1. connect the DMI hardware interface to the PC. 

2. Make sure that the driver is installed 

 

Press Settings 

The COM port must previously have been  

read/set in “Peripherals Management”  

(see Reading the DMI interface COM port)  

to be recognized. If there are errors, refer to the  

paragraph “DMI interface connection error”. 

* the COM settings must be set on all of the workspaces: Application, Device and User Interface 

Connection to Smart 

1 

2 

3 
4 
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           Connect to the target 

 

 

 

 

Protocol Configuration 

●For Smart select EWDMI or Modbus*. If the protocol is not activated 

press the Activate button 

●The value selected for the COM port will be saved and will reappear each 

time the program is accessed, until it is changed. 

●The properties are visible and can be edited from the panel Communication 

> Settings > Properties** 
 

                                                                                           * in the case of Modbus for /S models only with maximum speed   

                                                                                             19200 baud. TTL not for use. NOT POSSIBLE TO UPDate the BIOS. 

                                                                                           ** obviously, the protocol must be activated beforehand 

Factory default configuration: 

 

Address:1, Baud rate: 9600 

E,8,1 (CF30=1, CF31=3, CF32=1) 

 

 

 

 



93 Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh 

DMI interface connection error 

Error opening serial port 

 

If the “Error opening serial port” message appears, proceed as follows: 

 

1.Check that the COM port setting in the program is the same as one read in 

the COM port reading by the DMI interface. 

 

2. Check if Com Server is opened when you try to connect to Evolution. If not 

disconnect TTL cable,  USB port and reconnect first USB and then TTL. 

 

 

 

 

3. Repeat the DMI Detection function. 
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Target and Free Studio 

Parameters needed for correct connection between the Smart target and Free 

Studio. 
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Customize Smart Baud Rate 

Smart parameters in the CF folder manages the connection between the target and Studio 

If the target is “empty”, i.e. there is no IEC application on the device, Smart will display the 

message FrEE, otherwise fundamental state is displayed (Press F5 to switch to FrEE menu)  

1 

2 
3 4 

5 
6 
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Customize Smart Baud Rate by FS Device 

Only After Connection has been estabilished: 

 

1. Project ►BIOS parameters►All parameters►Configuration 

2. CF31 editing►38400 bits/Sec. 

 

2 

1 

Protocol parameters are loaded at power up, remember 

to switch off controller after changing them. 
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Free Studio Device - Main icons 

1 2 3 4 5 
1. Continuous read/write by toggle auto 

refresh mode. As soon as value changes, 

it will automatically aligne with the target. 

2. Select all variables 

3. Read all device parameters 

4. Write all device parameter 

5. Download all (PLC & parameter) 

6. It is possible to check the firmware 

version via information.  

 

 

 6 
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Free Studio Device - Colors 

1. If the auto referesh is on the 

column value is continiously 

updated and values are written as 

soon as you change them. 

Color meanings: 

Red: not aligned with the target 

Grey: read only data 

Blue: value is different from default 

Green: data is not visible in the target 

Black: aligned with the target  

(if auto referesh is enabled). 

 

 

1 

1 
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Connect to the target and Download All 

1. Connect 

2. Download All 

3. Write the default 

parameter values 

4. DMI Blink: 

Communicating 

 

1 
2 

3 

2 

4 
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Editing value 

1. Be sure to be Connected 

2. Set or change the value (Red, not applied) 

3. Write the parameter (Black, applied) 

 
1 

2 

3 

2 
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Oscilloscope 

Drag & Drop 
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Oscilloscope 

1. Show all values 

2. Graph properties 

3. Value/div=20 ► OK 

4. Vertical split 

 

 

 

1 2 4 

3 
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Oscilloscope 
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Debug on-line/Watch 

Select variable to watch 

 

 

 

1 

2 

4 
3 
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Chapter 7 

Target conversion and code import 

 

Goal: 

Reuse of existing code and libraries 
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Convert project from Smart to Evolution 

1. Project ► Select target 

2. Free evolution EVD* 

3. Change 

4. Save the project 

 

1 

3 

2 

4 By target conversion, it is possible 

to reuse the existing projects. 
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Converted project from Smart to Evolution 

Conversion between Evolution to Smart is 

not fully supported (all resources are 

deleted). 
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Import Objects from library (or Project) 

Both directions, upgrade &  

downgrade are possible, from: 

Smart ► Evolution 

Evolution► Smart  

It allows also to import programs, FB, functions from other projects regardless the related target. 
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Import Objects from Project... 

1. Select *.ppjs file type 

2. Select desired project (Smart ) 

3. Select desired program & FBD 

4. Import Objects 

 

1 4 

3 

2 
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...Assign to Task (in case of program) 

1. ? Means that program is not assigned to any task 

2. Tasks ► Background ► Add program 

 

1 

2 
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Assigning imported program to the task 

 

1. Select  the desired program 

name ► OK 

2. The ? Disapeares in prgrams  

3. It will assign to to desired 

task (delete non-required 

programmes) 

 

1 

1 

2 2 

3 
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2 

Link libraries... 

1. Project ► Library Manager 

2. Project Library list 

3. add/remove 

4. Unlink/Relink 

1 

4 

3 

2 
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...Link Libraries 

1 

2 
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Save a project as: 

File ► save a project as : 

 

* Create a folder for the 

project before saving  

* 
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Q & A 
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Thanks 


